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The Mayan Temple of Kukulkan, Chichén Itzá, Mexico 

– Blender To Google Earth 
 

In this tutorial we will examine the process of placing a Blender model into the Google 
Earth application. Google Earth provides satellite imagery depicting the entire earth and 
allows users to insert three-dimensional objects at specific latitudinal and longitudinal 
locations.  
 
Blender Configuration Requirements:  
 
Before starting this tutorial, download and read the 
“ConfiguringBlenderForGoogleEarth.pdf” file located in the Temple Of Kukulkan PDF 
tutorial area of this course site. This file contains important information about 
configuring Blender version 2.46 so that it will properly export .dae (Digital Asset 
Exchange) files to Google Earth along with UV mapped textures. If your model does not 
contain any UV mapped textures you can use the standard Blender 2.46 configuration. 
 
Tutorial Files:  
 
All of the files needed for this tutorial are located in the TempleOfKukulkan.zip file. 
Create a new folder on your desktop named “Kukulkan”. Open the 
TempleOfKukulkan.zip file in WinZip or some other zip utility, select all, and unzip to 
the new Kukulkan folder on your desktop. This is an important step as all of the image 
files must be in the same directory as your .blend and exported .dae file. 
 
Step #1 – Obtaining a Google Earth Footprint: 
 
Before creating a model in Blender that is destined to be placed in Google Earth it is a 
good idea to first sample the position (latitude and longitude) in the Google Earth 
Environment. 
  
Open Google Earth. In the “Fly To” box, type in your home address.  
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Click the ENTER key. Google Earth will fly to your home address. Zoom in to get a 
better view.
 
In the “Layers” panel make sure “terrain” is check marked. You can use the Rotate, 
Zoom and Tilt controls in the upper right hand corner to alter the view.  
Here is a satellite view of my house:
 

 
 
Adjust your view so that your house is in the center of the display looking straight down 
with the rotation pointing Due North. 
 
Select File / Save Image.  
 



 
 
Save the image to your computer. If you were to model your house and place it into 
Google Earth, this image would server as a footprint providing an aspect ratio of your 
house’s length and width. It will also indicate the angle you house is set from due North. 
This is handy if you do not know the exact dimensions or angles of the object you are 
modeling.  
 
You can also use the Google Earth tape measure tool to measure objects depicted in the 
imagery. Go back to Google Earth and select the “ruler” tool: 
 

 
  
A dialogue box will open allowing you to set the measurement units. Click on one corner 
of your house and then another. The readout will give you a “rough” measurement. (you 
may want to zoom in). 
 



 
 
Center your house again in the display. You can now obtain the Latitudinal and 
Longitudinal location of your house. In the current place panel you will see the address 
you typed in. Right-Click (CTRL-Click MAC) and choose “Properties” from the 
dropdown box. 
 

 
 
This displays the display properties dialogue box. Select the “View” tab; then click on 
“Snapshot Current View”. This will display the coordinates of the current Google Earth 
view. 



 
 
Close Google Earth. Do not save any locations to your Places Panel. 
 
Google Earth provides fairly high resolution satellite imagery for most populated places 
on earth. However once you get into the countryside or less populated places the 
resolution degrades and it is hard to locate distinct structures. This is the case with the 
object we will use in this tutorial. The Mayan Temple of Kukulkan is located in the 
remote jungle of Yucatan peninsula in Mexico and the resolution for this area is very low. 
However many remote archeological areas have satellite imagery of their own and it is 
possible to “overlay” these images on Google Earth. 
  
There is a satellite image overlay file in the TempleOfKukulkan.zip file named 
overlay.jpg. We will use this image to create an overly in Google Earth from which we 
can then extract a footprint of the site.  
 
Open Google Earth. In the address line type in the following:  
20 40 59N,88 34 06W  



These are the coordinates for the Kukulkan Pyramid area.  
Click on the Begin Search Button  
 

 
Google Earth will fly to those coordinates. From the main menu select Add / Image 
Overlay. 
 

 
 
An Image Overlay dialogue box is displayed along with a yellow rectangle in the display. 
Name the Overlay “Overlay of Chichen Itza Area”. Place the following text in the 
description box: “Coordinates: 20°40'59 N, 88°34'06" W”.  
 



 
 
Click on the Browse button and select the overlay.jpg image from the KukulkanPyramid 
folder.  
 

 
 
Click OK. This will place the overlay image on the display centered in the rectangle.  
 



 
 
Right-Click on the Overlay of Chichen Itza Area link now listed in the Places panel on 
the left. Choose Properties. In the Properties dialogue box there is a slider that allows us 
to adjust the transparency of the overlay. Set it so it is about 65 percent opaque.  
 

 
 
The overlay is a bit off its mark. Click and drag the center-point of the yellow rectangle 
and move it a bit to the left aligning the rod that runs north with the overlay and the GE 



display. You may also have to enlarge the overlay by dragging on the corner mark as 
shown below:  
 

 
 
When you are satisfied with the position, click OK. We now have an overlay of the 
pyramid area.  
You should be able to zoom in and locate the stepped pyramid. 
 



 
 
 
From the main menu select File / Save / Save Image. Save this file as KPOverlay.jpg to 
the Kululkan folder.  
 

 
 
We now have a footprint image of the model area (KPOverlay.jpg) that we could use as a 
base for the Blender modeling. 
  
If we were to now begin modeling the pyramid in Blender, we could use the 
KPOverlay.jpg image as a Top View background to get a very good understanding of the 
length, width and angle of the pyramid. 
 



As this is a tutorial focuses on placing a Blender model into the Google Earth 
environment (and not a general Blender modeling tutorial), I have already created a 
simple base model of the Kukulkan Pyramid to use in this tutorial. 
  
Note: In most instances you will not have to include an overlay image but rather take the 
information directly from Google Earth. It is only when the area resolution is too low that 
an overlay is needed. 
  
You can now close Google Earth. Do not save any locations to your Places panel. 
  
Step #2 – The Blender Model: 
  
Open the KukulkanPyramid.blend file located in the Kukulkan folder.  
 

 
 
Generally speaking, 3D models placed in Google Earth do not reveal a lot of detail. 
Consideration should also be given to the following:  

 • Mesh Objects – Google Earth will import all Blender mesh objects. All mesh 
polygons are imported as triangles. All extrusions must be at least 0.1  

 
 • Camera – Google Earth does not make use of the Blender Camera object. You 

might as well delete it from your Blender model.  
 • Lighting – Google Earth does not import any Blender lighting. All Google 

Earth models are displayed in an even ambient light with no highlights or 
shadows. There is no need to place any lighting objects in your Blender model.  

 • Animation – Google Earth does not import any animation keyframes set in your 
Blender model.  



 • Bezier, NURBS, Meta, Armature and Deformation objects all need to be 
converted to Mesh Objects before exporting.  

 • Materials/RGB Textures – Google Earth will import simple RGB materials 
created in Blender. However, it will not import any textures applied to RGB 
materials. For instance, noise, procedural, environmental or image mapping will 
not be imported.  

 • UV Mapped Textures – Google Earth will import UV mapped textures. Any 
textures applied to your Blender model must be UV mapped. However, unlike the 
rendering inside of Blender the “TexFace” button in the Material Panel of the 
Material Buttons is NOT activated.  

 
Step #3 – UV Texture Mapping: 
  
Google Earth models created in Blender will display all regular RGB colors as well as 
any UV mapped textures. Since proper UV mapping is critical to viewing Blender created 
textures in Google Earth, we will apply some UV mapping to our KukulkanPyramid 
model. 
  
Change the left 3D viewport to top view NUM-7 and click on the ZKEY to switch out of 
shaded mode to wireframe mode. 
 

 
 
Select (right mouse button) the “base” object.  
 



 
 
TAB into Edit mode. 
 
Change the right 3D Viewport from 3D View to UV /Image Editor.  
 

 
 
In the left 3D viewport press the AKEY to select all of the vertices from the selected base 
object. 



 

 
 
From the Mesh menu choose UV Unwrap (or press the UKEY) 



 
 
This displays the UV Calculation dialogue box. Select Cube Projection  
 



 
 
This unwraps all of the faces in the base object and places them in a “cube” unwrap 
position in the UV Image Editor. (You may have to use your scroll wheel to zoom in or 
out in the UV Image Editor)  
 



 
 
In the UV Image Editor window, click on the Image button then Open.  
Select the stone.jpg image from the Kukulkan folder. This places the stone.jpg image on 
the faces of the base object.  
 

 
 
Change the display mode in the left 3D viewport from wireframe to textured. 



 
 
You can see the results in the left viewport by rotating the view.  
 

 
 
In the right UV Image Editor window, scale (SKEY) the vertices up until the size of the 
stone texture as seen in the left viewport is to your liking. 
 

 



Note: If we wanted to remove this UV mapping we would have to:  
1) Click on the “X” in the UV Mapping Editor 
 
And  
2.) Click on the “Delete” (TexFace) button in the Mesh Panel of the F9 Editing Buttons  
 
 
Set the left 3D viewport back to top view (NUM7). TAB back to object mode. ZKEY 
back into solid shading view. 
 
(RMB) Select the lower stair object (do not include the railing objects). 
 

  
 
TAB into Edit mode. Press the AKEY to select all of the vertices. 



 
 
From the Mesh Menu, select Unwrap UVs then Cube Projection.  
In the UV Image Editor click on the Image Button then Open and load the romanwall.jpg 
image from the KukulkanPyramid folder. This applies the image to the faces of the lower 
stairs. 

 
 
Switch back to Object Mode. Repeat the UV mapping process on the other 3 stair objects.  
 



 
 
When you are finished UV mapping the stair objects switch back to Object Mode. Switch 
the right Viewport back to 3D view and switch the Draw mode back to wireframe. 
  
We will now create a simple material to use on the stair rail objects. Select one of the 
stair rail objects.  
 

 
 



Go to F5 Shading. In the Links and Pipeline panel, click on Add New material button.  
 

 
 
Set the RGB sliders in the Material Panel to a dark grey and name the material 
StairRailGrey in the Links and Pipeline Panel. 
 

  
 
Select each of the other rails in turn and apply this same material to the objects. 
 

  
 
Switch to textured view. The materials are now applied to the Blender model.  
 



 
 
Note: As with many instances of UV mapping of textures it is sometimes important 
before applying the UV mapping to:  
1.) Select each object and turn off “Double Sided” in the Mesh Panel of the F9 Editing 
buttons.  
And  
2.) Select each object, TAB to Edit Mode, AKEY select all vertices and CTRL-N 
Recalculate Normals Outside. 
 
I already did this on the Kukulkan.blend file model.  
 
Step #4 – Exporting the Blender Model: 
  
Save your model and rename it KukulkanPyramidCompleted.blend. Save it in the same 
directory as the KukulkanPyramid.blend file. This is VERY IMPORTANT! The .blend 
and the image files and the exported file for Google Earth MUST be in the same 
directory.  
 
We will now export the geometry to a .dae file that can be interpreted by Google Earth.  
Select File / Export / Collada 1.4 (.dae)  



 

 
 
Set the file name as Pyramid.dae.  
Set the file path so that the Pyramid.dae file is exported to the KukulkanPyramid folder.  
Select Triangles (Google Earth will only import triangles via the Collada Export)  
Select Disable Physics (Google Earth will import it anyway)  
Select Use Relative Paths (This will help Google Earth to find the texture files)  
Click on “Export and Close”.  
 



 
 
An “Export Successful” note will appear on the screen. You can now close Blender.  
 
Step #5 – Creating the KMZ File: 
  
The process of placing the Blender model into Google Earth and creating a KMZ file that 
can be shared with others is fairly easy. Open Google Earth. In the address line type in 
the following:  
20 40 59N,88 34 06W  
These are the coordinates for the Kukulkan Pyramid area.  
Click on the Begin Search Button  
 
Note: your Overlay of Chichen Itza Area may still be displayed if it is listed under “My 
Places” (and checked). If the old overlay is still displayed u can right-click the listing in 
the Places panel and delete it (we will add a new one) 
 
First we need to create a folder. Select the Temporary Places in the Places 
Panel and Right-Click. Select Add / Folder  



 

 
 
Name this folder “Kukulkan Pyramid”. Leave the description box blank. Do NOT 
checkmark Show contents as options (we want all of the folder elements displayed by 
default).  
 

 
 
Click OK. This creates a folder in the Places Panel.  
 



 
 
We have created a folder because we have a number of elements to add to the KMZ file 
(an overlay, a model and a placemark). To keep this in one file we needed to create a 
folder and make sure we put all of out elements in that folder. 
  
We will now add the overlay image. Select the Kukulkan Folder in the Temporary Places 
Panel. Right-Click and select Add / Image Overlay.  
 

 
 
An Image Overlay dialogue box is displayed along with a yellow rectangle in the display. 
Name the Overlay “Overlay of Chichen Itza Area”. Place the following text in the 
description box: “Coordinates: 20°40'59 N, 88°34'06" W”. Click on the Browse button 
and select the overlay.jpg image (NOT the KPOverlay.jpg) from the KukulkanPyramid 
folder. 
 
Click OK. This places the overlay image on the display centered in the rectangle. Right-
Click on the “Overlay of Chichen Itza Area” link now listed in the Places panel on the 



left. Choose Properties. In the Properties dialogue box there is a slider that allows us to 
adjust the transparency of the overlay. Set it so it is about 65 percent opaque. The overlay 
is a bit off its mark. Click and drag the centerpoint of the yellow rectangle and move it a 
bit to the left aligning the road that runs north with the overlay and the GE display and 
scale it up a bit by dragging on a corner handle as shown below: 
 
When you are satisfied with the position, click OK. We now have an overlay of the 
pyramid area.  
 

 
 
We will next add the model. Before we add the model uncheck the “20 40 59N,88 34 
06W” link in the Fly To /Search Panel. This placemark will get in the way and is not 
needed. 
 

  



 
Select the Kukulkan Pyramid Folder in the Places Panel. Right-Click and select Add / 
Model. (Make sure you right-click on the folder and not the overlay) 
  

 
 
It is important that the model be added to the Folder and not the overlay.  
 
This displays the new model dialogue box. Name the model “The Mayan Temple of 
Kukulkan” and type in the following description: “The Mayan Temple of Kukulkan, 
Chichén Itzá, Mexico”.  
 

 
 
Click on the Browse button and select the Pyramid.dae file that we exported from 
Blender which should be located in the KukulkanPyramid folder. 
 



Click OK. This imports the Blender model into the Google Earth environment. However 
the scale of the Blender model is considerably smaller than the Google Earth scale. Zoom 
out and you will see that the model is but a small speck on the landscape. 
 
Zoom in so that you can clearly see the Blender model. Right-Click the “The Mayan 
Temple” link located in the Places Panel and select Properties.  
 

 
 
Notice that the Blender model is now enclosed by a yellow box.  
 

 
 



Move your cursor to the bottom right corner of the box until the cursor changes to a 
double arrow. Click and drag the corner of the box and the model will scale up while 
dragging.  
Continue to zoom out a bit and drag the corner of the box out scaling the model until it is 
close to the proper size. (Note: you may have to drag out (scale) the model many times, 
zooming out after each scale up.) 
  

 
 
Move your cursor to the center of the box until a finger appears then click and drag the 
box. This allows you to “grab” it and move it.  
Move and scale the box so that it is located over the overlay image of the pyramid.  
 



 
 
Move your cursor to the little yellow circle on the left or right side of the box. Your 
cursor will again turn into a pointed finger. Click and drag your cursor. This allows you 
to rotate the model.  
 

 
 
Move, scale and rotate the model until it appears to fill the area of the overlay pyramid 
image. You may have to rotate your Google Earth view to get a good look at it. 



 

 
 
When you are satisfied with the scale, rotation and position, click the OK button in the 
dialogue box. Rotate the display view to see the model. 
 

 



 
Select the model again in the folder, right-click and choose properties. Rotate the display 
view so you are looking at the model from about eye level.  
 

 
 
Note that the model is enclosed by a yellow cube. Select the Altitude tab from the 
dialogue box. Note that by default the model is “clamped to the ground”. You can adjust 
the vertical placement of the model by clicking on the dropdown box and choosing 
“relative to ground”.  
You can now adjust the vertical position of the model by using the slider or entering a 
value in meters (m). In our case we do not have to make an adjustment. However, 
depending on the ruggedness of the terrain some models will need a vertical adjustment.  
Make scale, position, rotation or vertical position adjustment to fit the model to the 
overlay as desired. When you are satisfied with the final positioning, click on the OK 
button on the dialogue box Rotate the zoom the view until you find one you like (like 
below).  
 



 
 
Right-Click “The Mayan Temple of Kukulkan” link in the Places panel and select 
Properties.  
Select the View Tab and then click on “Snapshot current View”. This will record the 
current view in the properties for this element. Click OK when done. 
 



 
 
We will now add a Placemark. Select the Kukulkan Folder in the Places panel and Right-
Click it and select Add / Placemark. 
 



  
 
Note that we added the Placemark to the Folder, not the model or the overlay.  
We now have a Placemark in the Display View. 
 
Click on the Altitude Tab of the New Placemark dialogue box. Move the slider to the 
right a bit until the Altitude for the Placemark is about 70 meters. Checkmark the Extend 
to Ground box. 
 
The Placemark is now above the pyramid in the display view with a line extending to the 
ground. Grab the Placemark with your curser and position it directly above the pyramid. 
Name the Placemark in the dialogue box “The Temple of Kukulkan”  
 

 



 
Click on the description tab. Add the following to the description box:  
<img 
src="http://www.isourcecom.com/maya/cities/chichenitza/chichenimages/castil3.jpg" />  
<br /><br>  
El Castillo - the great temple-pyramid of Kukulkan (Feathered Serpent), Chichen Itza, 
Yucatan, Mexico built by the Toltecs whose arts and Mexican architectural style 
influenced the ancient Maya<br><br>  
<a href="http://www.isourcecom.com/maya/cities/chichenitza/il.htm">More 
Information</a>  
Note the description contains text, an HREF link and an img src image. 
 
Click on the Icon Style button in the upper right-hand corner of the dialogue box.  
This displays an icon selection chart.  
 

 
 
Select “Add Custom Icon” in the lower left corner. This displays a dialogue box which 
alls us to add a custom icon. Click on the Browse button and select the blendericon.png 
file from the KukulkanPyramid folder. 
 
Click OK to the Icon selection dialog box and click OK on the Placemark dialogue box. 
The Blender icon is now above the model.  
 



 
 
Note also that the Blender icon is now listed in the Places panel. 
 

  
 
The final procedure we need to do is to make sure all of the View Tab properties for each 
element and for the folder are the same. First set the view in the display to how you want 
the users to view the model. Next, open the Properties dialogue box for the Overlay 
element. Select the “View” Tab then “Snapshot Current View”. Click OK. Do the same 
to the model element properties box and the placemark element properties box. 
Finally (and it is important to do this last), open the properties box for the folder, 
select the View Tab then Snapshot Current View. Click OK.  
 
We can now make the KMZ file.  
Select the Kukulkan Folder listing in the Places Panel and right-Click. Select Save Place 
As. (Make sure you do this to the folder and not one of the elements).  
 



 
 
Name the file KukulkanPyramid (.kmz) and save it to the Kukulkan Folder. After the file 
is saved, check your directory to make sure it is there. 
 
You can now close Google Earth. Do not save any locations to your Places panel.  
 
Reopen Google Earth. Go to File / Open and open the newly created 
KukulkanPyramid.kmz file. Google Earth will fly to the location and view and display 
the model, overlay and placemark.  
 



 
 
Note that you can click on the + icon in the Places panel to open up the folder and reveal 
each element. Click on the Blender icon in the display. This displays a balloon pop-up 
that contains the Text / HREF / Image code we added to the Placemark description. 
 
You can, at any time, open the KMZ file in Google Earth, make edits (even add more 
elements). When you are done editing, Snapshot all of the element views, select the 
folder and right-click Save As. 
  
Step #6 – Distributing the KMZ File:  
 
The KukulkanPyramid.kmz file contains all of the information needed by Google Earth 
to display the model and associated overlay and placemark. The KMZ file is actually a 
type of ZIP file which contains all of the image files, the DAE file we exported from 
Blender, a TXT file associating the textures and a KML file that calls the rest of the files. 
It is even possible to unzip the KMZ file using a Zip utility program like WinZip. 
 
One way to distribute your Blender models is to simply distribute the KMZ file. Models 
created in Blender / Google Earth cannot be stored in Google’s 3D Model Warehouse. 
Perhaps someone will create a Blender 3D model warehouse to share Blender / Google 
Earth models.  
 
Copies of all of the files used in this tutorial are located in the TempleOfKukulkan.zip 
file located on our course site. 


